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22. Parámetros para la inclusión de un pozo de extracción en el

modelo. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxii
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1. Prólogo

2. Introducción

3. Ecuaciones gobernantes

3.1. Flujo de agua subterráneo

3.1.1. Acúıfero Confinado

Las ecuaciones del flujo de un acúıfero confinado que se presentan a continua-
ción, han sido desarrolladas por varios autores tales como Hantush (1964),
Bittinger (1967), Bear (1972), Kreager-Rover (1975) y Remson (1971).

La siguiente ecuación describe el flujo de agua en un acúıfero confinado en el
régimen no permanente o de no-equilibrio para un medio poroso heterogéneo
y anisotrópico:

∂

∂x

(
Kx

∂h

∂x

)
+

∂

∂y

(
Ky

∂h

∂y

)
+

∂

∂z

(
Kz

∂h

∂z

)
= Ss

∂h

∂t
+ q, (1)

donde K es el tensor de conductividad hidráulica, h es la carga hidráulica, Ss

es el almacenamiento espećıfico que tiene en cuenta tanto la compresibilidad
del agua como la compresibilidad del medio poroso y q es un término fuente,
generalmente un pozo de inyección o extracción.

3.1.2. Acúıfero libre

Según Hantush (1964), las ecuaciones del flujo tridimensional en un acúıfero
confinado, también describen el flujo tridimensional en un acúıfero libre con
las variantes de que la carga hidráulica se mide con la base del acúıfero libre
como datum y que cualquier punto de la superficie freática debe satisfacer
una condición ĺımite describiendo su posición. La Ec. (1) por lo tanto, es
válida en cualquier punto del acúıfero mientras que la Ec. (2) es aplicable
sólo en los puntos de la superficie fréatica.

Kx

(
∂h

∂x

)2

+ Ky

(
∂h

∂y

)2

+ Kz

(
∂h

∂z

)2

−Kz
∂h

∂z
= Sy

∂h

∂t
+Q, (2)

donde Sy es el rendimiento espećıfico del acúıfero libre.

1



3.2. Transporte multicomponente en una fase fluida

La ecuación utilizada para el transporte multicomponente en una fase fluida
en un medio poroso es la siguiente:

∂ (φciρ)

∂t
= −∇ · (ciρu− ρDi∇ci) + qi i = 1, 2, ..., Nc, (3)

donde ci, qi, y Di son la concentración volumétrica, término (fuente o sumi-
dero), y el tensor de difusión-dispersión del i−ésimo componente, respecti-
vamente, y Nc es el número de componentes en el fluido. La restricción para
la concentración es

Nc∑
i=1

ci = 1. (4)

Las fuentes o sumideros de un componente pueden resultar de la inyección
y producción de este componente por medios externos. También puede ser
causado por varios procesos dentro de la fase fluida, como reacciones qúımi-
cas entre componentes, decaimiento radiactivo, biodegradación, y crecimien-
to debido a actividad bacterial, esto causa el incremento o decremento del
componente en cuestión. En este proyecto sólo se tendrá en cuenta las reac-
ciones qúımicas, es decir, se abordará el problema de flujo reactivo en medios
porosos.

Cuando un componente participa en reacciones qúımicas causa que su con-
centración aumente o disminuya, qi puede ser expresado como

qi = Qi − Lici, (5)

donde Qi y Li representa la producción qúımica y tasas de pérdidas, respec-
tivamente del i−ésimo componente.

4. Ejemplos de aplicación práctica del uso de

PMWIN

4.1. Flujo de agua incompresible en estado estaciona-
rio en un acúıfero libre, homogéneo e isotrópico.

En esta sección se presentará un ejemplo bastante simplificado de la utiliza-
ción del software PMWIN, mostrando todos los pasos necesarios para crear
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un modelo computacional y simular la Ec. (1) en estado estacionario consi-
derando un medio homogéneo e isotrópico en ausencia de términos fuente.
Realizando estas consideraciones, la Ec. 2 puede escribirse como:

∇2h = 0, (6)

la cual corresponde a la conocida ecuación de Laplace.

4.1.1. Interfaz gráfica de PMWIN

PMWIN ofrece una interfaz gráfica bastante atractiva y muy amigable con
el usuario. Luego de la instalación, una vez abierto el programa, la interfaz
gráfica se ve como en la Fig. 2. En este caso, el programa ha sido instalado
en Windows XP SP3.

Figura 2: Interfaz gráfica de Processing Modflow (PMWIN).

4.1.2. Creación de un nuevo proyecto

Para crear un nuevo proyecto clickear en File > New Model. Lo recomenda-
ble es crear una carpeta para cada proyecto, ya que una vez que se empiece a
trabajar con él, se crean varios archivos auxiliares. Una vez creada la carpe-
ta (que en este caso denominamos caso1) se escribe el nombre del proyecto
(ejemplo uno). La extensión con la cual se guarda el archivo se denomina
.PM5. Las Figuras 3a y 3b ilustran el proceso mencionado anteriormente.
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(a) Creación de un nuevo modelo. (b) Nombre del modelo.

Figura 3: Pasos para la creación de un nuevo proyecto en PMWIN.

4.1.3. Dimensión del modelo

El siguiente paso para la creación de un modelo implica la creación de una ma-
lla discreta. PMWIN utiliza algoritmos numéricos para aproximar las ecua-
ciones (1) y (3) debido a que las soluciones anaĺıticas no existen o se restringen
a escenarios muy sencillos. Aśı, un método numérico (en este caso PMWIN
utiliza diferencias finitas) precisa de nodos discretos donde se resuelven las
ecuaciones proporcionadas en el modelo. La simulación en tres dimensiones
necesita de nodos en las direcciones x, y, y z. El número de capas correspon-
den al número de nodos en k, el número de columnas al número de nodos
en la dirección j y el número de filas al número de nodos en la dirección i,
(véase Fig. 4).

Figura 4: Modelo esquemático de un dominio discreto en PMWIN mostrando
los nodos en las direcciones i,j y k.

Para crear una nueva grilla, ir a Grid > Mesh Size. Automáticamente apa-
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recerá una ventana como la que se muestra en la Fig. 5. La ventana precisa de
5 parámetros de entrada; el número de capas (k), el número de columnas (j),
el tamaño de cada columna (es decir, la distancia entre dos nodos contiguos
en la dirección j), el número de filas (i) y el tamaño de cada fila. Para este
ejemplo, se utilizarán 3 capas, 30 columnas, el tamaño de cada columna será
de 20 m, 30 filas y el tamaño de cada fila será de 20 m.

Figura 5: Parámetros de entrada necesarios para establecer la dimensión del
modelo.

Una vez clickeado en el botón OK aparecerá la grilla creada con el número de
filas, columnas y capas establecidos (véase Fig. 6).

Figura 6: Malla computacional con 30 nodos en j, 30 nodos en i y 3 nodos
en k.

Ahora podemos hacer click en el ı́cono de salir (primer ı́cono que se encuentra
en la esquina superior izquierda) y hacemos click en Sı́ cuando pregunte si
quiere guardar las modificaciones.
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4.1.4. Tipo de capa

Una vez creada la malla, es necesario determinar el tipo de capa (o ca-
pas si es que se han establecido más de una). Para ello, hacemos click en
Grid > Layer Type. PMWIN desplegará una ventana mostrando automáti-
camente todas las capas establecidas en la sección 2.1.3, véase Fig. 7.

Figura 7: Configuración de los tipos de capa.

Entre las opciones de tipos de capa contamos con:

0 Confinado

1 No confinado

2 (Confinado/No Confinado) Transmisibilidad constante

3 (Confinado/ No Confinado) Transmisibilidad variable

Para este ejemplo consideraremos un acúıfero con la primera capa no confi-
nada y dos capas confinadas, por lo tanto debemos hacer click en la opción
[1], acúıfero no confinado para la primera capa y luego click en la opción [0]
para las capas 2 y 3. Por último, hacemos click en OK. Si nos dirigimos a
Grid veremos que las opciones Mesh Size y Layer Type ya se encuentran
configuradas.

4.1.5. Condiciones de frontera

Las condiciones de frontera son las que definen los ĺımites entre el siste-
ma en estudio y el universo. Es por eso, que la definición correcta de las
mismas es de vital importancia para que los modelos computacionales repre-
senten correctamente el fenómeno a simular. Para configurar las condiciones
de frontera debemos hacer click en Grid > Boundary Condition > IBOUND

(Modflow), y aparecerá la malla que creamos anteriormente.
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PMWIN cuenta con tres tipos de condiciones de frontera:

-1 Nodo con carga hidráulica fija.

0 Nodo con carga hidráulica inactiva.

1 Nodo con carga hidráulica activa.

Los nodos con carga hidráulica fija [-1] son constantes durante toda la si-
mulación, los nodos con carga hidráulica inactiva [0] son ignorados por el
software y técnicamente corresponden a una condición de Neumann de flujo
impermeable, es decir, no puede fluir agua a su través, y los nodos con carga
hidráulica activas [-1] son nodos internos donde se resolverán las ecuaciones
de flujo. Para este ejemplo consideraremos todas las celdas como activas,
exceptuando la de las columnas este y oeste.

Para evitar la selección individual de cada celda (por razones obvias de tiem-
po) es conveniente resetear toda la matriz con el valor [1]. Para ello, presio-
namos la combinación de teclas control + R, escribimos 1 y presionamos
OK (véase Fig. 8a).1 Para configurar las columnas este y oeste como cargas
hidráulicas fijas seleccionamos la primera celda (celda de la esquina superior
izquierda), hacemos click derecho y escribimos -1, veremos que la celda se
tornó azul. Nuevamente, configurar todas las celdas de forma individual con-
sumirá mucho tiempo, para ello, PMWIN cuenta con la opción clonar celda
(Switch Duplication On/Off). Una vez que la duplicación se encuentre ac-
tiva, podemos desplazarnos con el cursor para seleccionar todas las celdas
de la columna este y luego las de la columna oeste. Una vez finalizado este
proceso debemos desactivar la opción de duplicación (véase Fig.8b). Además,
debemos definir las condiciones de frontera para las capas 2 y 3. Para ello, es
muy útil la opción de copiar capa (Switch Layer Copy On/Off), activando
este ı́cono y escribiendo 2 y luego 3 en la opción de número de capa podemos
directamente copiar las configuraciones de la capa 1. Por último salimos de
IBOUND (Modflow) guardamos las modificaciones.

4.1.6. Tope y fondo de capas

Si bien, hemos definido anteriormente el tamaño de las columnas y de las
filas, aún no hemos definido la altura de las capas. Para ello, PMWIN ofrece
dos parámetros, Tope de capas y Fondo de capas. Estos son los parámetros
que definirán los tamaños de las celdas en k, es decir, de las capas. Como en

1Es conveniente presionar el ı́cono con la opción Switch to Local Coordinate

System para visualizar mejor el dominio.
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(a) Matriz reseteada con valor 1. (b) Columnas con valor -1.

Figura 8: Configuración de las condiciones de frontera.

este ejemplo estamos trabajando con tres capas, sdebemos definir tres topes.
Para ello, nos dirigimos a Grid >> Top of Layers (TOP). En este caso
asumiremos que todas las celdas de la primera capa tienen la misma altura,
por lo que es conveniente resetear la matriz con control + R e ingresar la
altura, 10 m (véase Fig. 9a). Luego, definimos la capa 2 con una altura de 6
m y la altura de la capa 3 con 3 m. Para la configuración del fondo de capas
realizamos el mismo proceso, nos dirigimos a Grid > Bottom of Layers

(BOT) y reseteamos la matriz con el valor 6 m para la primera capa (véase
Fig. 9b), 3 m para la segunda capa y 0 m para la tercera capa.

(a) Tope de capas. (b) Fondo de capas.

Figura 9: Configuración del tope y del fondo de capas.

4.1.7. Parámetros temporales

En este ejemplo estamos resolviendo la Ec. (6) por lo que la distribución de
carga hidráulica dentro del dominio es independiente del tiempo. Sin embar-
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go, computacionalmente es conveniente adoptar un tiempo elevado de simu-
lación para garantizar el estado estacionario. Esto puede configurarse con la
opción Parameters > Time Parameters donde aparecerá una ventana que
contiene la información de los parámetros temporales (véase Fig. 10). Aqúı,
debemos configurar un sólo paso de tiempo (Time Steps = 1) con un valor
alto, como mencionamos anteriormente (Length = 9.46728 E+07) segundos
y luego hacemos click en OK.

Figura 10: Configuración de parámetros temporales para el estado estacio-
nario.

4.1.8. Cargas hidráulicas iniciales

La configuración de las cargas hidráulicas iniciales son fundamentales cuando
resolvemos modelos que contienen celdas con cargas hidráulicas fijas ya que
en este proceso se establecen sus valores. Sin embargo, como los valores de las
celdas activas cambiarán instantáneamente en el primer paso temporal, estas
son independientes de los valores de carga hidráulica inicial. De esta forma,
lo que haremos es ingresar a Parameters > Initial Hydraulic Heads y
resetear la matriz con valores de carga hidráulica inicial igual a 8 m, hasta
este momento todas las celdas (tantos activas como de carga fija adoptan
el valor de 8 m). Luego definiremos los valores de carga hidráulica de la
columna oeste con un valor igual a 9 m (véase Fig. 11) ya que los valores
de la columna este ya fueron anteriormente fijados con un valor de 8 m. Aśı,
el flujo de agua irá desde la zona de mayor carga hidráulica (lado oeste) a
la zona de menor carga hidráulica (lado este). Por último, con la opción de
copiar capa, clonamos las configuraciones de carga hidráulica inicial de la
primera capa y lo asignamos a la capa 2 y a la capa 3.
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Figura 11: Configuración de cargas hidráulicas iniciales.

4.1.9. Conductividad hidráulica horizontal

El siguiente paso consiste en establecer los valores de las conductividades
hidráulicas del medio poroso. Para configurar los valores de conductividad
hidráulica nos dirigimos a Parameters > Horizontal Hydraulic Conductivity

y reseteamos la matriz con un valor de 0,0001 m/s (véase Fig. 12) para la
primera capa, 0,0005 para la segunda capa y 0,0005 para la tercera capa.

Figura 12: Configuración de la conductividad hidráulica horizontal.

4.1.10. Conductividad hidráulica vertical

Aśı como hemos definido las conductividades hidráulicas horizontales para las
tres capas en la sección anterior, debemos definir las conductividades hidráuli-
cas verticales. Para ello, nos dirigimos Parameters > Vertical Hydraulic
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Conductivity reseteando la matriz con un valor de 0,00001 m/s (véase Fig.
13) para la primera capa, 0,00005 para la segunda capa y 0,00005 para la
tercera capa. Notar que los valores de la conductividad hidráulica horizon-
tal generalmente son 10 veces superiores a los valores de la conductividad
hidráulica vertical.

Figura 13: Configuración de la conductividad hidráulica vertical.

4.1.11. Porosidad efectiva

La porosidad efectiva también debe ser especificada de tal manera a conocer
el volumen total efectivo de fluido que puede fluir a través de la matriz
porosa. Para establecer la porosidad efectiva nos dirigimos a Parameters

> Effective Porosity y reseteamos la matriz con un valor de porosidad
efectiva igual a 0.25 para la primera capa (véase Fig. 14). Finalmente, con la
opción de copiar capa, clonamos la configuración de la capa 1 para la capa 2
y la capa 3.

4.1.12. Resolución del modelo

Ahora estamos en condiciones para resolver el modelo computacional. Para
ello, nos dirigimos a Models > MODFLOW > Run. Al hacer click automáti-
camente se abrirá una ventana (véase Fig. 15a) con varias opciones para la
salida de archivos, generalmente estas opciones pueden ser dejadas por de-
fecto. Al hacer click en OK se desplegará una ventana de la consola nativa
de Windows (véase Fig. 15b), para este tipo casos la simulación no debeŕıa
tardar más de unos segundos.
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Figura 14: Configuración de la porosidad efectiva.

4.1.13. Presentación de resultados

Para presentar los resultados en PMWIN primeramente debemos ingresar
a Tools > Presentation. Una vez que ingresemos a esta opción debemos
extraer los resultados haciendo click en Values > Result Extractor, se
abrirá una ventana como se muestra en la Fig. 16 a la que debemos clickear
en Read.

Una vez extráıdo los resultados para la capa 1 debemos aplicar los resultados
haciendo click en Apply y luego en Close. En este momento tenemos los
resultados de la distribución de carga hidráulica guardados en la memoria.
Para graficar los resultados entramos a Options > Environment la cual

(a) Parámetros de salida. (b) Consola de solución.

Figura 15: Resolución del modelo con el módulo MODFLOW.
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Figura 16: Extracción de resultados.

despliega la ventana que se muestra en la Fig. 17a.2 Si hacemos click en la
pestaña Contours se despliega la ventana que se muestra en la Fig. 17b.

(a) Ventana Environment (b) Ventana Contours

Figura 17: Opciones de presentación de resultados.

Para crear los contornos debemos activar la opción Visible y Fill contours

y luego la opción Restore Defaults. Al hacer click en OK aparecerá la distri-
bución de carga hidráulica (véase Fig. 18). Los resultados son los esperados,
una disminución lineal y uniforme de la carga hidráulica desde la columna
oeste (h = 9m) a la columna este (h = 8m) para la primera capa.

La imagen del resultado de la simulación puede ser fácilmente guardada en
varios formatos. Para ello, nos dirigimos a File > Save Plot As (véase Fig.
19). Entra las opciones de archivos podemos elegir DFX3, Windows Bitmap
BMP y HPGL.

2En la ventana Environment es conveniente desactivar la opción Grid
3Los archivos DFX pueden ser editados en AutoCad c©
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Figura 18: Distribución de carga hidráulica.

Figura 19: Ventana para guardar los resultados de la simulación.

4.2. Flujo de agua incompresible en estado estaciona-
rio en un acúıfero libre, homogéneo e isotrópico
considerando recarga de agua.

El paquete Recharge está diseñado para simular la recarga distribuida sobre
una superficie determinada en el sistema de agua subterránea. Para simular
la recarga podemos utilizar el Caso 1 como punto de partida.

4.2.1. El paquete Recharge

Para incluir los efectos de recarga en el modelo computacional nos dirigimos
a Models > MODFLOW >> Recharge. La opción más sencilla es resetear la
matriz para configurar un valor representativo de la superficie del dominio
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(véase Fig. 20).4 En este caso designamos un valor de 8× 10−9 m/s de recarga.
Notar que la recarga sólo es aplicada a la primera capa.

Figura 20: Configuración de los parámetros de recarga.

Además, el paquete Recharge cuenta con la opción de establecer los valores
de recarga por capa en el caso de ser necesario y/o contar con la información
de campo.

4.2.2. Presentación de resultados

Para presentar los resultados, procedemos de la misma forma que se ha ex-
plicado en la sección 2.1.13. En la Fig. 21 se puede ver como la recarga de
agua afecta considerablemente la distribución de carga hidráulica dentro del
acúıfero. Al comparar la Fig. 21 con la Fig. 18 se puede notar que las ĺıneas
equipotenciales de carga hidráulica ya no son equidistantes.

4.3. Flujo de agua incompresible en estado estaciona-
rio en un acúıfero libre, homogéneo e isotrópico
considerando recarga de agua y un pozo de ex-
tracción.

4.3.1. El paquete Well

El paquete Well se utiliza para agregar pozos de inyección y/o extracción
de agua. Para ello, nos dirigimos a Models > Modflow > Well y PMWIN
nos mostrará el dominio del modelo. En PMWIN un pozo de inyección o
extracción es representado por una celda. El usuario debe especificar una

4Si se disponen de distintos valores de recarga en distintas superficies del dominio se
pueden crear zonas para asignar los valores para cada área de recarga.
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Figura 21: Distribución de carga hidráulica considerando el efecto de recarga
de agua.

tasa de inyección o extracción por cada celda. MODFLOW puede simular
los efectos de bombeo de un pozo que penetra más de una capa del acúıfero
proveyendo los caudales de bombeo para cada capa. La tasa total de bombeo
para el pozo multicapas es igual a la suma de todas las tasas de bombeo
de las capas individuales. La tasa de bombeo para cada capa (Qk) puede
ser estimada dividiendo la tasa total de bombeo (Qtotal) en proporción a la
transmisibilidad de cada capa (McDonald and Harbaugh 1988).

Qk = Qtotal
Tk∑
Tk
, (7)

donde Tk es la transmisibilidad de cada capa k y
∑
Tk es la suma de las

transmisibilidades de todas las capas penetradas por el pozo multicapas.
Infortunadamente, como la primera capa es no confinada, no sabemos exac-
tamente el espesor saturado y la transmisibilidad de esta capa en la ubicación
del pozo. La Ec. (7) no puede ser utilizada a menos que se conozca un espesor
saturado para calcular la transmisibilidad. Otra posibilidad para simular un
pozo multicapas es definir una conductividad hidráulica vertical muy alta
(por ejemplo 1 m/s) para todas las celdas del pozo. La taza total de bombeo
es asignada a la celda más profunda del pozo. Para propósitos de presenta-
ción, una tasa muy pequeña de bombeo (por ejemplo 1× 10−10 m3/s) puede
ser asignada a las otras celdas del pozo. De esta forma, la tasa exacta de
extracción para cada capa penetrada será calculado por MODFLOW impĺıci-
tamente y el valor puede ser obtenido utilizando el Water Budget Calculator.
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(a) Tasa de extracción.

(b) Pozo de extracción en color rojo.

Figura 22: Parámetros para la inclusión de un pozo de extracción en el mo-
delo.

El pozo se ubicará en la celda [25,15,3] y tendrá un caudal de extracción
de -0,0012 m3/s (véase Fig. 22a). Automáticamente, la celda que contiene el
pozo de extracción se torna roja (véase Fig. 22b). Las capas 1 y 2 se definen
con un valor de extracción de -1× 10−10 m3/s para las posiciones [25,15,1]
y [25,15,2] respectivamente. Por último, debemos dirigirnos nuevamente a
Vertical Hydraulic Conductivity y definir la conductividad hidráulica igual a
1 m/s para las posiciones [25,15,1], [25,15,2] y [25,15,3].

4.3.2. Presentación de resultados

La Fig. 23 muestra la distribución de carga hidráulica en estado estacionario
para nuestro modelo, considerando recarga y además una extracción de agua
utilizando un pozo de extracción situado al este del dominio. Como se puede
apreciar, las ĺıneas equipotenciales de carga hidráulica cambian abruptamente
en las cercańıas del pozo. Esto se debe al descenso en la presión de agua en
las zonas aledañas al pozo. Además, se puede apreciar que afecta de forma
uniforme y radial a la carga hidráulica.

4.4. Caso 4: Particle Tracking con PMPATH

PMPATH es un modelo de transporte advectivo que se ejecuta independien-
temente a PMWIN. PMPATH utiliza los modelos de agua subterránea y los
resultados de simulación de PMWIN y MODFLOW. Un esquema de segui-
miento de part́ıculas semi-anaĺıtico (Pollock, 1988, 1989) es utilizado para
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Figura 23: Distribución de carga hidráulica para la primera capa consideran-
do recarga y un pozo de extracción.

calcular la trayectoria y los tiempos del agua subterránea. A través del en-
torno gráfico e interactivo de PMPATH podemos disponer part́ıculas dentro
del dominio y realizar el seguimiento de las mismas. La ventaja de PMPATH
es que no necesita ningún tipo de post-procesamiento para la visualización de
las trayectorias computadas. Además, PMPATH provee varias opciones gráfi-
cas que incluyen el trazado de contornos de distribución de carga hidráulica y
vectores de velocidad de flujo para cualquier capa del modelo y para cualquier
tiempo de simulación (véase Fig. 24).

Figura 24: PMPTAH en operación.

Para simulaciones en estado no estacionario, las part́ıculas pueden comenzar
desde el inicio de cualquier nivel de tiempo. Durante la simulación, el algo-
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ritmo de seguimiento de part́ıculas corroborará el tiempo actual para cada
part́ıcula. Si una part́ıcula alcanza el final o el inicio de un nivel de tiempo,
PMPATH fuerza a la part́ıcula a esperar, hasta que el campo de flujo del
próximo nivel de tiempo haya sido léıdo. La simulación de seguimiento de
part́ıcula procede hasta que todas las part́ıculas hayan abandonado el modelo
mediante algún pozo o hasta que especifiquemos que el tiempo de simulación
ha sido alcanzado.

El paso de tiempo para el seguimiento de una sola part́ıcula y el máximo
número de pasos de seguimiento pueden ser especificados. Cada part́ıcula
puede tener su propio color e incluso un factor de retardo. Con estas capaci-
dades, PMPATH puede ser empleado para simular el transporte advectivo de
aguas subterráneas, para delinear zona de capturas de contaminantes, zonas
de inyección y áreas de extracción de agua protegidas o para encontrar el
punto de origen de fuentes de agua en zonas espećıficas. PMPATH genera
varios archivos de salida incluyendo distribución de carga hidráulica, cam-
pos de velocidad, las coordenadas x, y, z y los tiempos de trayectoria de las
part́ıculas. Los gráficos pueden guardarse en distintos formatos, incluyendo
DXF, HPGL y BMP.

4.4.1. Particle tracking utilizando el modelo presentado en la sec-
ción 2.3

Utilizando el ejemplo presentado en la sección 2.3 delinearemos la zona de
captura del pozo de extracción. Para ello, abrimos el módulo de PMPATH:
Models > PMPATH (Pathlines and Contours). La interfaz gráfica de PM-
PATH se muestra en la Fig. 25.

La Fig. 25 muestra el dominio en cuestión, en tres vistas: una vista del plano
x−y, una vista del plano x−z (abajo) y una vista del plano y−z (derecha).
Es conveniente exagerar las proporciones de estos dos últimos planos para
realizar un mejor análisis de los resultados. Para computar la exageración
nos dirigimos a Options >> Environment y hacemos click en la pestaña
Cross Sections y en la opción Exageration escribimos 30. Además, como
analizaremos la zona de captura, debemos establecer la proyección de los pla-
nos en la celda correspondiente al pozo de extracción, es decir, en la opción
Projection Row escribimos 15 y en la opción Projection Column escribi-
mos 25. Luego hacemos click en OK y el dominio aparece como se muestra
en la Fig. 26. Como se puede apreciar en el plano x − z se muestra el pozo
de extracción en color rojo, cuya profundidad, atraviesa la totalidad de la
capas. Otra información interesante es la ĺınea sólida azul que atraviesa todo
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Figura 25: Interfaz gráfica de PMPATH.

el plano en la horizontal, la cual denota la altura de la superficie de la capa
freática.

Figura 26: Dominio computacional en PMPATH con una exageración de 30
y proyectando los planos en la ubicación del pozo de extracción.

Ahora estamos en condiciones de agregar part́ıculas en alguna zona del do-
minio. Es conveniente cambiar el color de las part́ıculas (que por defecto son
rojas) a un color distinto a la del pozo de extracción, por ejemplo, verde para
la primera capa, azul para la segunda capa y rosado para la tercera capa. A
continuación, seleccionamos la cruz para seleccionar un área conformada por
las celdas 4,12,1→ 7,12,1→ 7,18,1→ 4,18,1. Una vez seleccionada esta
región, se abrirá una ventana como se muestra en la Fig. 27a, para agregar
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las part́ıculas, colocaremos 3 part́ıculas dentro de cada centro de cada celda.
El dominio con las nuevas part́ıculas incluidas en la región anteriormente
mencionada se muestra en la Fig. 27b.

(a) Ventana para agregar part́ıculas.

(b) Nuevas part́ıculas añadidas.

Figura 27: Proceso de adición de nuevas part́ıculas en PMPATH.

Por último, para graficar la zona de captura del pozo de extracción debemos
hacer click en Run Particles Forward, luego de presionar el botón apro-
ximadamente tres veces tenemos delineada la zona de captura (véase Fig.
28).

Figura 28: Zona de captura de part́ıculas del pozo de extracción en estudio.

Al inspeccionar la Fig. 28 podemos notar como el conjunto de part́ıculas
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que hemos agregado se desplaza. La zona de captura toma la clásica forma
parabólica que puede ser apreciada en el plano x− y. Además, se puede ver
como las part́ıculas descienden significativamente debido a los efectos de la
gravedad (véase plano x− z).

4.5. Caso 5: Inclusión de ŕıos

PMWIN también ofrece la posibilidad de incluir ŕıos, lagos y arroyos que se
encuentren hidráulicamente con un acúıfero mediante el módulo River. El
Paquete River es utilizado para simular el flujo de agua entre un acúıfero
y una superficie de agua, como ŕıos, lagos o reservorios. Los ŕıos son defini-
dos utilizando el paquete River, que se encuentra en Models > MODFLOW >
River. Los ŕıos son definidos celda por celda (o en todo caso seleccionado
una zona) y es necesario asignar tres parámetros de entrada:

Conductancia hidráulica del lecho del ŕıo CRIV [L2 · T−1]

Carga en el ŕıo HRIV [L], y

Elevación del fondo del lecho del ŕıo RBOT [L]

Si la carga hidráulica (h) en una celda de ŕıo es mayor que RBOT , la tasa
de descarga (QRIV ) desde el ŕıo hacia el acúıfero es calculada a partir de la
Ec. (8).

QRIV = CRIV · (HRIV − h) h > RBOT. (8)

Para el caso en el que h es mayor que HRIV , QRIV es negativa. Esto implica
que el agua fluye desde el acúıfero hacia el ŕıo y es removida del modelo de
agua subterránea. Cuando h ha cáıdo por debajo del fondo del lecho de ŕıo,
la tasa de descarga hacia a través del lecho del ŕıo está dada por la Ec. (9).

QRIV = CRIV · (HRIV −RBOT ) h ≤ RBOT. (9)

El valor de CRIV de una celda de ŕıo es comúnmente dado por

CRIV =
K · L ·W

M
, (10)

donde el valor K es la conductividad hidráulica del material del lecho del ŕıo,
L es la longitud del ŕıo dentro de una celda, W es el ancho del ŕıo y M es el
espesor del lecho del ŕıo.
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4.5.1. Proceso de inclusión de un ŕıo

Ahora estamos en condiciones de agregar un ŕıo al modelo, para ello seleccio-
namos la primera celda del modelo [7,9,1] y establecemos la conductancia
hidráulica del lecho del ŕıo igual a 0,001 m2/s, la carga en el ŕıo 9,5 m y la
altura del lecho del ŕıo igual a 7 m (véase Fig. 29a). Le damos OK y luego
seleccionamos la herramienta clonar celdas y nos desplazamos hasta la celda
[18,9,1], el dominio se debeŕıa ver como en la Fig. 29b.

(a) Parámetros del ŕıo.

(b) Inclusión de un ŕıo al dominio.

Figura 29: Proceso de inclusión de un ŕıo al modelo de agua subterránea.

4.5.2. Presentación de resultados

Una vez guardado los cambios y resuelto el modelo de agua subterránea
considerando la inclusión del ŕıo, podemos analizar su influencia en la dis-
tribución de carga hidráulica dentro del acúıfero. La distribución de carga
hidráulica se muestra en la Fig. 30a. Se puede apreciar, cómo la presencia
del ŕıo afecta considerablemente la distribución de las ĺıneas equipotencia-
les de carga hidráulica. Cerca de de la zona circundante al ŕıo, los valores
de carga hidráulica son máximos, y se acercan al valor de la carga del ŕıo
HRIV que en este caso corresponde a 9, 5 m. Luego, mientras nos despla-
zamos hacia la derecha (dirección natural del flujo de agua subterránea) los
valores de carga hidráulica van disminuyendo. También se puede observar
que el pozo de extracción sigue afectando la distribución de carga hidráulica
debido a la remoción de agua del modelo. En la Fig. 30b se muestra el nivel
de la superficie freática (en ĺınea sólida azul en el plano x− z) la cual ha au-
mentado en la zona cercana al ŕıo. Se debe notar, que aún, cuando PMWIN
trata a las recargas, pozos de inyección o extracción, y ŕıos y lagos de forma
separada, todos se consideran términos fuente Q en la Ec. (1). En este caso
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en particular, la contribución del ŕıo al término fuente es positiva (es decir,
ingresa agua al modelo) y la contribución del pozo es negativa (es decir, se
remueve agua del modelo).

(a) Distribución de carga hidráulica
(b) Superficie freática

Figura 30: Resultados considerando la inclusión de un ŕıo en el modelo ma-
temático.

4.6. Caso 6: Simulación del transporte de solutos

Básicamente, el transporte de solutos en medios porosos puede ser descrito
por tres procesos:

Advección,

Dispersión hidrodinámica,

Reacciones f́ısicas, qúımicas o bioqúımicas.

Los modelos MT3D y MOC3D usan el método de caracteŕısticas para si-
mular el transporte advectivo, en el cual, sustancias qúımicas disueltas son
representadas por un número de part́ıculas y las part́ıculas se mueven con el
agua subterránea. Además del método de caracteŕısticas, los modelos MT3D
y MT3DMS proveen otros métodos para resolver el término advectivo.

La dispersión hidrodinámica puede ser expresada en términos de dispersi-
vidad [L] y el coeficiente de difusión molecular [L2T−1] para el soluto en el
medio poroso. Los tipos de reacciones incorporadas dentro de MOC3D están
restringidas a aquellas que pueden ser representadas por una tasa de reacción
de primer orden, como decaimiento radiactivo, o por un factor de retardo,
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como reacciones de adsorción y desorción (instantáneas o reversibles) gober-
nadas por una isoterma lineal y un coeficiente de distribución constante.

En adición a la isoterma lineal, MT3D soporta isotermas no lineales, como las
de Freunlich y Langmuir. Antes de ejecutar los módulos MT3D y MOC3D,
se necesita definir pozos de observación, desde los cuales será posible calcular
las curvas ruptura.

4.6.1. Definición de pozos de monitoreo

Los pozos de observación son perforaciones que se realizan en las estructuras
geológicas con el fin de controlar algún parámetro fisicoqúımico (en este caso
la concentración de soluto) a lo largo del tiempo. Para definir un pozo de
monitoreo nos dirigimos a Parameters > Boreholes and Observations,
inmediatamente se despliega una ventana tal y como se muestra en la Fig.
31. Se pueden definir varios pozos de monitoreo, en este caso definiremos dos
pozos de observación, el primero se ubicará en la posición [X=290, Y=310] y
el segundo en [X=390, Y=310]. Notar que se deben definir ambos pozos de
observación en las tres capas del modelo (véase Fig. 31).

Figura 31: Ubicación de un pozo de observación.

4.6.2. Simulación del transporte de solutos con MT3D

MT3D precisa de la asignación de un código de condición de frontera para
cada celda del modelo, estas son:

-1 Celda de concentración constante
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0 Celda de concentración inactiva

1 Celda de concentración activa

Las celdas de carga hidráulica activas pueden ser tratadas como celdas de
concentración inactivas para minimizar el área necesaria para la simulación
del transporte, siempre y cuando la concentración de solutos cerca de esas
celdas sea insignificante. Análogamente al modelo flujo de agua subterránea,
es necesario especificar la concentración inicial para cada celda del modelo.
La concentración inicial en una celda de concentración constante (celda tipo
[-1]) quedará invariable durante toda la simulación. Para las celdas activas,
se utiliza como valor inicial para el proceso de resolución de las ecuaciones
de transporte.

A continuación se describirá los pasos necesarios para realizar una simulación
de transporte de solutos considerando la presencia de solutos en el ŕıo y la
contaminación debido a recarga:

→ Asignación de condiciones de frontera
Para asignar las condiciones de frontera nos dirigimos a Grid > Boundary

Condition > ICBOUND (MT3D/MT3DMS). En este caso, consideraremos
todas las celdas como activas, aśı que basta con resetear la matriz asig-
nando el valor 1 a todas las celdas.5

→ Establecimiento de los valores iniciales de concentración
Nos dirigimos a Models > MT3D > Initial Concentration. Para es-
te caso asignaremos el valor de 0 para todo el dominio, ya que las fuentes
de contaminación serán la recarga y el ŕıo.

→ Ingreso de contaminantes debido a la recarga
Elegimos Models > MT3D > Sink/Source Concentration >
Recharge. Seleccionamos la celda (4,13,1) y establecemos un valor6 de
12500 µg/m3. Luego seleccionamos la opción de duplicar celda hasta
abarcar el área designada por las celdas (4,13,1) → (7,13,1) →
(7,17,1) → (4,17,1), tal y como se muestra en la Fig. 32a.

→ Ingreso de contaminantes debido al ŕıo
Elegimos Models > MT3D > Sink/Source Concentration >>
River. Seleccionamos la celda (7,9,1) y establecemos un valor de

5No olvidar aplicar las condiciones de frontera a las capas 2 y 3 utilizando la opción de
copiar capa.

6Este valor es la concentración asociada con el flujo de recarga. Como la tasa de recarga
es de 8× 10−9 m/s y la tasa de disolución es 1× 10−4 µg/s/m2, la concentración asociada
con el flujo de recarga es 12500µg/m3
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100µg/m3, luego seleccionamos la herramienta de copiar celdas y nos
desplazamos hacia la derecha hasta seleccionar el ŕıo en su totalidad
(véase Fig. 32b).

(a) Contaminación por recarga. (b) Contaminación debida al ŕıo.

Figura 32: Ingreso de contaminantes debido a recarga y ŕıo.

→ Configuración de los parámetros de advección
Para configurar los parámetros del paquete de advección nos dirigimos
a Models > MT3D > Advection. Inmediatamente una ventana apare-
ce. Seleccionaremos el Método de Caracteŕısticas para el esquema de
solución y el algoritmo de Euler de primer orden para el seguimiento
de part́ıculas (véase Fig. 33).

Figura 33: Configuración de los parámetros de advección.

→ Configuración de los parámetros de dispersión
Para ajustar los parámetros de dispersión nos dirigimos a Models >
MT3D > Dispersion. Una ventana de diálogo aparecerá donde debe-
mos establecer tres parámetros:
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• Dispersividad horizontal transversal / Dispersividad longitudinal
(TRPT)

• Dispersividad vertical transversal / Dispersividad longitudinal (TRPV)

• Coeficiente de difusión molecular efectiva (DMCOEF)

Establecemos los valores mostrados en la Fig. 34a y luego hacemos click
en OK. Ahora debemos establecer el valor de la dispersividad longitudi-
nal dentro del dominio. Para ello, reseteamos la matriz con un valor de
10 (véase Fig. 34b). Por últimos copiamos la primera capa y asignamos
los mismos valores a la segunda y tercera capa.

(a) Parámetros de dispersión.

(b) Dispersividad longitudinal.

Figura 34: Configuración de los parámetros de dispersión.

→ Configuración de los parámetros de reacción qúımica
Elegimos Models > MT3D > Chemical Reaction > Layer by Layer.
Una ventana de diálogo del paquete de reacciones qúımicas aparecerá.
De-seleccionamos la opción que simula el decaimiento radiactivo o la
biodegradación y seleccionamos la opción de isoterma de equilibrio li-
neal. Para la isoterma lineal, el factor de retardo para cada celda es
calculada al principio de la simulación utilizando la Ec. (11).

R = 1 +
ρb
n
·Kd, (11)

donde n [-] es la porosidad efectiva con respecto al flujo a través del
medio poroso, ρb es la densidad del medio poroso y Kd es el coeficiente
de distribución de soluto en el medio poroso. Como la porosidad efectiva
es igual a 0,25, estableciendo ρb = 2000 kg ·m−3 y Kd = 0,000125
m3 · kg−1 obtenemos R = 2 (véase Fig. 35).

→ Configuración de los parámetros temporales de salida
Nos dirigimos a Models > MT3D > Output Control y una ventana
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Figura 35: Configuración de los parámetros para reacciones qúımicas.

de diálogo aparecerá. Las opciones en esta ventana están agrupados en
tres pestañas:

• Output Terms

• Output Times

• Misc

Por el momento, podemos dejar la primera y la última pestaña con
las configuraciones por defecto y nos dirigimos a la segunda pestaña
Output Times. Aqúı debemos establecer el valor de los intervalos de
tiempo para la salida de los resultados de las ecuaciones de transporte.
En este caso, establecemos un intervalo igual 3000000 s (véase Fig.36a)
lo cual creerá inmediatamente una tabla con 33 niveles de tiempo (véase
Fig. 36b).

→ Resolución del modelo con transporte de solutos
Para resolver el modelo, primeramente es necesario resolver el flujo de
agua subterránea. Una vez realizado este proceso, estamos en condicio-
nes para resolver las ecuaciones de transporte con el módulo MT3D.
Nos dirigimos a Model > MT3D > Run . El tiempo de simulación para
resolver las ecuaciones de transporte es de aproximadamente 30 segun-
dos.

4.6.3. Presentación de resultados

En la Fig. 37a se muestran los contornos correspondientes a la distribución de
concentración para un tiempo de simulación de 3 años. Se puede apreciar que
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(a) Intervalo de tiempo.

(b) Tabla generada.

Figura 36: Configuración de los parámetros temporales para el transporte de
solutos.

tanto el ŕıo, como la zona de contaminación debido a la recarga contribuyen al
desplazamiento de la pluma del contaminante. Otra opción muy importante
que provee PMWIN son los gráficos de concentración - tiempo que se pueden
generar una vez que hemos establecido los pozos de monitoreo. Para acceder
a este gráfico nos dirigimos a Tools > Graphs > Concentration-Time >
MT3D. Una vez abierta la ventana seleccionamos las casillas correspondientes a
los pozos de monitoreo. Las curvas de concentración - tiempo son interesantes
para conocer la evolución de la pluma de contaminante, por ejemplo, en el
caso de un proceso de remediación, si la concentración disminuye con el
tiempo una posibilidad es que la ubicación del pozo de extracción sea la
correcta, sin embargo, también puede darse el caso en el que la pluma se está
”desviando”de la zona donde se toman las mediciones de concentración. Por
ello, los resultados deben analizarse con mucha precaución. Es aqúı donde
radica la importancia de colocar inteligentemente los pozos de monitoreo.
Las curvas para el caso en estudio pueden verse en la Fig. 37b.
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(a) Contornos de concentración. (b) Curvas de concentración-tiempo.

Figura 37: Resultados de simulación de transporte de solutos.
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